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A1 ACOUSTIC RHINOMETER SAFETY INFORMATION 

Read this Operating Manual before attempting to use the Instrument. 
 

WARNINGS 
 

This instrument is for indoor use only and it should be used as described in this manual. 
 

The system must not be used in the presence of flammable gases or in an environment which is 
susceptible to explosions - beware of oxygen, dust, and anaesthetic gases. 

 

To avoid risk of electric shock this equipment must be connected to a mains supply with a 
protective earth. 

 

If your desktop PC or printer does not have a power supply approved for a patient environment, 
then an isolation transformer, which complies with BS EN 60601, should be used to power the PC, 
printer, and the A1 Acoustic Rhinometer. You must use the isolation transformer to ensure that 
the A1 Acoustic Rhinometer is in compliance with BS EN 60601. 

 
As this is a mains-powered, PC-connected product it is advisable to not touch the patient while 
using the equipment. 
 
The computer may not be connected to the internet. 

 
The equipment should be positioned in such a way that it can be easily disconnected from the 
mains supply. The operation of the system can be safely terminated by switching off the device or 
removing the mains plug. 

 

The applied part is the nosepiece, which is marked for single use. It should not be re-used, as no 
method of sterilisation can be guaranteed; disinfection materials may not be effective and may 
leave a residue, which could be harmful. 

 
 

CAUTIONS 
 

The nosepieces are made of a material, which may cause an irritation reaction in some patients. 
Use of the nosepiece should be discontinued in patients who exhibit such a reaction. 

 

Nosepieces are a single-use item. Single-use items should not be re-used as they could transfer 
infections between subjects. 

 
Federal (USA) law restricts this device to sale by or on the order of a physician. 

 
The use of an A1 Acoustic Rhinometer near to sources of electromagnetic radiation, such as 
mobile phones, radio transmitters, x-ray equipment etc., may prevent it from functioning 
correctly. 
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The A1 Acoustic Rhinometer is a medical instrument, which has an electrical classification of Class 
l Type B and a Medical Device Directive classification of IIa. A Class l Type B device categorisation is 
used to describe an instrument which: 

 

a) Does not rely on basic insulation only to provide protection against electrical shock but is 
constructed in such a way that accessible metal parts cannot become live in the event of failure of 
the basic insulation, and 
b) Applied parts offer protection to the subject against electrical shock and in the event of a 
single fault condition arising, leakage current will be limited to less than 0.5 mA. 

 
Any serious incident that has occurred in relation to the device should be reported to the 
manufacturer and the competent authority of the Member State in which the user and/or patient 
is established. Contact GM Instruments at the address on page 10. 

 

A1 should only be connected to other mains-powered devices such as computers and printers, 
which comply with EN 60950-1 and we also advise the use of an isolation transformer. Unless 
computers and printers built to EN 60950 are used, patient safety might be compromised. 

 

Non-medical equipment such as computers and printers should be kept out of reach of subjects 
being tested as such equipment does not comply with medical safety standards. Refer to clause 16 
of EN 60601-1:2006 to ensure compliance. 

 

If the PC is allowed to go into sleep mode, the USB interface is powered down. When brought out of 
sleep mode, the PC does not re-initialise the USB interface, and therefore it is effectively not present. 
A solution is to remove the USB connection at the PC or instrument side then re-connect. That may 
be sufficient, but if not, save any results, then close down the instrument software and restart it. 

 

Servicing can only be carried out by GMI approved and authorised 
personnel. No modifications are allowed. 

 

 
 

Standardisation Document. 
 

Customers are referred to the under noted International Standardisation Committee publication 
which contains recommendations on the use of Acoustic Rhinometers. 

 
Acoustic Rhinometry: Recommendations for technical specifications and standard operating procedures. 

Rhinology supplement number 10, December 2000 Ole Hilberg and Ole Pedersen 
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INTENDED USE 
The A1 Acoustic Rhinometer is used to quantify nasal obstruction. The device is intended to be used 
by a Health Care Professional for non-invasive examinations of the nasal cavity using a sound pulse 
technology.  
 

INDICATIONS FOR USE 
The A1 is indicated for use where nasal obstructions are suspected, or when quantification of the 
nasal cavity before and after a procedure or challenge is required. 
 

INTENDED USERS 
 

The A1 Acoustic Rhinometer provides information to assist ENT Surgeons, Allergists, researchers into 
nasal function and those involved in sleep studies with information to guide their treatments and 
research. Typically, any medically trained technician, nurse, or doctor will be considered competent 
to use the device. 
 

INTENDED POPULATION 
The A1 Acoustic Rhinometer is intended to be used in paediatric and adult populations (including 
pregnant and breast-feeding women), regardless of gender.  
 

BENEFITS  
The A1 Acoustic Rhinometer has the following Benefits 
1. Able to quantify the level of nasal obstruction 
2. Provides a rapid non-invasive examination 
3. Can be used for pre/post comparisons to assess outcome of intervention or therapy 

 

DESCRIPTION of the A1 Acoustic Rhinometer 
The A1 Acoustic Rhinometer allows a very rapid non invasive examination of the nasal cavity using a 
sound pulse technique.   
 
The device comprises a hardware unit, with the sound tube attached by a cable, and software 
running on a computer. The sound tube contains a microphone, and is coupled to the test subject’s 
nose with a nosepiece. The hardware unit is powered by a separate power supply, and connected to 
a computer via a USB cable. 
 
Software running on the computer provides the user interface of the device, and sends and receives 
acoustic signals via the hardware unit. 
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Figure 1. The A1 Acoustic Rhinometer 
 

STORAGE 
The A1 Acoustic Rhinometer and its accessories should be stored within the following 
temperature and humidity ranges: 

 

Temperature -40C to +60C 
Humidity 30% to 90% RH non-condensing 

 

TECHNICAL SPECIFICATIONS 
Only factory-trained personnel or engineers who are familiar with the standard EN 60601 can 
undertake servicing of the A1 Acoustic Rhinometer. 
Circuit Diagrams will be made available to competent persons on request. 

 
 

Performance 
(using standard nose) 

Repeatability Better than 2% 

Volume Accuracy 
(0cm to 5cm) 

Better than 2% 

Minimum Area 
Accuracy 

(within 0cm to 
5cm) 

Better than 5% 

Area Range 
(max 20, default 

10) 

0.1 cm2 to 10 cm2 

Distance Range 
(using standard 

sound tube) 

0 cm to 12 cm 

Calibration User Calibrated 

Operation Environment Temperature +15 o C to +35 oC 
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Relative 
Humidity 

20% to 90% RH non-condensing 

Duty Cycle Continuous 

Warm Up Time 5 minutes 
Supply Universal voltage – external supply 

Power 10 Watts 

Transportation and Storage Temperature -40 °C to +60 °C 

 Relative 
Humidity 

30% to 90% RH non-condensing 

Mechanical Performance Size 27 x 8 x 30 cm 

Weight 2 Kg 
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TABLE OF SYMBOLS USED 
 

The following symbols appear on the A1 or the mains adaptor: 
 

Symbol Meaning Socket Type Location Connected Part 

 

 

Refer to Instruction 
Manual 
ISO7010-M002 

USB Connector Type 
B 

Instrument Back 
Panel 

Computer 
(Via USB port) 

5-Pin Din Socket Instrument Back 
Panel 

Mains AC/ DC 
Adaptor 
PCM50UT04* 

 

 

Type B 
Applied Parts 
IEC 60417- 5840 

JIS C 5432-Compliant 
5-Pin Socket 

Instrument Back 
Panel 

Sound Tube 

 Protective Earth 
IEC 60417 - 5019 

 

_ 

Instrument Back 
panel - Internal 

 

_ 

 Direct Current 
IEC 60417 - 5931 

 

_ 
Mains Adaptor 
AC/DC 

 

_ 

 
 

For connected parts marked * only connect the accessories supplied with the 
instrument. These parts have been tested for use with the instrument for 
compliance to standards IEC 60601-1 and IEC 60601-1-2. 

 
 

Symbols used on labelling and packaging: 
SYMBOL Indication 

 
Manufacturer 

 

EU Authorised Representative 
 

 

Date of Manufacture 

 

Catalogue Number 

 

Serial Number 

 
Medical Device 

 
Consult Instructions for Use 

 

CE Mark 

 

Do not re-use 
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Non- sterile 

 

Temperature Limit 
 

 

Humidity Limitation 

 

Unique Device Identifier 
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ADDRESS AND CONTACT DETAILS: 
 

MANUFACTURED BY:      
GM Instruments Ltd, Block 1 Annickbank Innovation Campus, Annick Road, Irvine, KA11 4LF, UK. 
 
TEL: +44 (0)1294 554664  
EMAIL: sales@gm-instruments.com  
WEBSITE: www.gm-instruments.com 
 
AUTHORIZED REPRESENTATIVE:       
Advena Ltd, Tower Business Centre, 2nd Flr, Tower Street, Swatar, BKR 4013, Malta 

mailto:sales@gm-instruments.com
http://www.gm-instruments.com/


Acoustic Rhinometer A1 Instructions for Use 
 

GM-001002-TF Issue 4    2025-08-07     Page 11 of 64 

INSTALLATION 

INSTALLING THE A1 SOFTWARE 
Installation of the A1 software is described fully in the accompanying manual titled: 

 
A1 Acoustic Rhinometer Software Manual 

 

 
INSTALLING THE A1 UNIT 

 
The A1 Acoustic Rhinometer can operate on any PC which runs a Windows based operating 
system which has a free USB socket. 

 
Connections between the A1 box, its sound tube, its power module and the PC are by means of 
polarised connectors which can only be inserted in the correct socket and with the correct 
orientation. 

 
Connect the sound tube and the power module prior to powering up the A1, but do not connect 
the USB cable until the A1 software and A/D board driver software are installed. 

 
N.B. Units which comply with EN60950 should be used. 
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USB 
SOCKET 

LINK 
SOCKET 

SOUND 
TUBE 

SOCKET 

POWER SOCKET 
FROM PCM5OUT04 

HARDWARE IDENTIFICATION 

Calibration plug ----- supplied with the A1 Clinical and A1 Clinical/Research 
Artificial nose and Straight Tube----- supplied with the A1 Clinical/Research 

 

 
 
 
 
 
 

A1 rear view and connections 
 

 

 
 
 

NOTE: LINK SOCKET ONLY USED WHEN CONNECTED WITH NR6 IN NARIS CONFIGURATION 
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INTRODUCTION 

Hardware and software have been provided with the A1 Acoustic Rhinometer to allow for the 
determination of Nasal Obstruction by plotting Nasal Area against Distance using Acoustic 
Reflections. 

 

The method is based on the following principle: 
 

A sound pulse propagates in a tube and enters the nasal cavity through a nosepiece, where it is 
reflected by local changes in cross-sectional area. The incident and reflected signals are then 
measured by a microphone in the sound tube. 

 
From these measurements, it is possible to calculate the cross-sectional area as a function of the 
distance into the cavity by use of algorithms developed by Ware and Aki (1969). 

 
By integration of this curve the volume of the nasal cavity is calculated. 

 

The method has been developed for use in the tracheo-bronchial system by Jackson et al. (1977), 
and for use in the nose by Hilberg et al. (1989). 

 

For further information, the reader should consult these publications: 
 

1. A.C. JACKSON, J.P. BUTLER, E.J. MILLET, F.G. HOPPIN Jr., and S.V. DAWSON. 
Airway geometry by analysis of acoustic pulse response measurements. 
J. Appl. Physiol. 43(3):523-536,1977. 

 
2. J.A. WARE, AND K. AKI. 

Continuous and discrete inverse scattering problems in a stratified elastic medium 
I. Plane waves at normal incidence. 
J. Acoust. Soc.Am.45:911- 921,1969. 

 

3. O. HILBERG, A.C. JACKSON, D.L. SWIFT, and O.F. PEDERSEN. 
Acoustic rhinometry, evaluation of nasal cavity geometry by acoustic reflection 
J. Appl. Physiol. 66:295303,1989. 
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HOW TO MAKE MEASUREMENTS 

The A1 can be used by any medically-trained technician, nurse or doctor, who has either read this 
manual or who has been trained by a competent authority in its use. 

 
Having become familiar with the hardware and software you are now ready to record 
measurements. 

 

CALIBRATION 
Prior to use the A1 device MUST be calibrated for correct operation. 
To perform a calibration, switch on the A1, put the calibration plug in the sound tube, click on the 
Acoustic icon on the main toolbar and then on the Calibrate button as shown below. 

 

 

A1 Acoustic Rhinometer [USB-201] calibrated will show when completed. 
 
 

A1 sound tube with calibration plug fitted, ready for 
calibration. 

 

The system is now ready for use. 
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PATIENT PREPARATION 

The patient should be prepared prior to testing, by having them wait in a quiet, stable 
environment for 15 to 20 minutes. If your interest is surgical and you want to look at structure, 
they should be decongested and asked to blow their nose prior to measurement. 
If your interest is in monitoring response to a decongestant or to an allergen, again the patient 
should be asked to blow their nose prior to measurement. 

 

The nosepieces supplied with the 
system include 15 conical and 5 pairs of 
each size of anatomical probes (medium 
& large). These are handed and colour-
coded, i.e. one is for use on the right 
side (red) and one for the left side 
(blue). 
N.B. The caution statement on page 3 at 
the front of this manual. 

 
 
 
 
 

The choice of nosepiece depends on which will give the best seal with the least distortion. 
The conical nosepieces are suitable for use with a nose which has a small round opening, while 
the anatomical nosepieces are designed to sit on the outside of a nose with a long narrow 
opening, and are shaped to make it easy, in most circumstances, to get a good seal. In addition, 
they have a flange which a soluble gel can be put onto to reduce any remaining gap. 
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MAKING MEASUREMENTS 

 
1) Have the patient sit back in a chair (some workers advocate use of adjustable forehead 

and chin rests), select and fit a nosepiece, and apply the sound tube (perhaps suitably 
prepared with gel) to the side to be measured. The sound tube can be held by the patient, 
or by the clinician but we believe this is best left to the patient, with one hand holding the 
sound tube near the bottom and one near the top. 

 
2) When suitably positioned, ask the patient to close their mouth and gently breathe in and 

out through their nose to check for leakage between the sound tube and nose. 

 
3) If OK, ask them to open their mouth and return to mouth-breathing. When ready to make 

the measurement, ask the patient to take a breath in through their mouth and hold their 
breath. Click on the red Acquire button, or middle-click on the mouse with the cursor 
inside the capture window to sample the data. This process can be repeated until at least 3 
consecutive results show little variation. If the patient can co-operate, the measurements 
may be made in rapid succession (with 600mS or so between samples) during a single 
breath-hold manoeuvre. 

 
4) If the results are satisfactory, select the other side (L or R), and repeat the process, 

remembering to change the nosepiece, if anatomical. 
 

5) The test results are automatically added to the patient’s results file. 

 
6) Click on Print to print out the currently highlighted curves, or alternatively click on Report 

to select the curves from the displayed list for printout. If you want a full page print out of 
a particular test, you can highlight it and click on the arrow on the right of the printer 
symbol and select Print on full page. 

 
7) The results can be saved by clicking on Save, confirming the file name to save to, and then 

clicking on OK. 
 

 
SWITCHING OFF 
The software can be closed by clicking on File and then selecting Exit from the drop-down menu. 
The hardware can be powered down by unplugging, or by switching off the mains plug. 
N.B. If you allow the PC to go to sleep or hibernate, the USB is disabled and will not re-initialise 
unless you either: 

a) Restart the PC or 
b) Close the A1 acquisition screen (if open), unplug the USB cable and then re-insert it. 

 
We recommend that you disable the sleep/hibernate function, under Windows. 
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FACTORS WHICH AFFECT ACCURACY 

 
Measurement accuracy and repeatability will depend on the following: 

 
Calibration: Perform a calibration at least twice a day 

 
Temperature: Use equipment in controlled conditions between 

+15°C & +35°C 
 

External noise: Use equipment in conditions where the background 
noise is below 65 dB 

 
Angle of probe (relative to the head): Aim for floor of nose 

Rigidity of probe: Doesn't move 

Effect of probe on the nose: Avoid distortion 
 

Patient co-operation: Hold breath during measurements 
 

Nosepiece/nose seal: Use gel and careful positioning to ensure a good seal. 
 

Check for leaks/Distortion: Repeat test at least twice if not 3 times and check for 
variation, i.e. apply/remove probe 2 or 3 times, 
testing each time and compare results. 

 

Electromagnetic disturbances: Exposure  to  excessive  fields  from  nearby  RF 
transmitters may the equipment not to function or 
measure correctly. If the measurement trace is not 
parallel to the horizontal axis in the first range of -4.5 
to 0 centimetres, then the results should be discarded 
as invalid. 

 
 

The Acoustic Standardisation Committee have now reported on the measurement and this is 
referred to on page 4 of this manual. 
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ENVIRONMENTAL FACTORS 

 
Temperature Effects 

 

An increase in the temperature of the gas through which the sound pulse travels lowers its density 
and therefore the rate at which it travels through the gas. The overall effect is in the range of 3% / 
20°C. Distance is therefore slightly overestimated if there is an increase in temperature. 

 
 

Altitude Effects 
 

The effect of altitude is significant on the density of a gas and, therefore, on the speed of sound at 
an altitude of 1000m. As such distance will be overestimated by 7%. 

 

Electromagnetic Disturbances 
 

Exposure to excessive fields from nearby RF transmitters may the equipment not to function or 
measure correctly. If the measurement trace is not parallel to the horizontal axis in the first range 
of -4.5 to 0 centimetres, then the results should be discarded as invalid. 
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START UP 

FILE MANAGEMENT 

A1 TROUBLESHOOTING 

If the PC is allowed to go into sleep mode the USB interface is powered down. When brought out of 
sleep mode the PC does not re-initialise the USB interface, which means that it is effectively not 
present. A solution for this is to unplug the USB connector at either the PC or instrument side and 
then re-connect. That may be sufficient, but if not, save any results, close down the instrument 
software, and restart it. 

 

An instance of the application is already active 
▪ The software is already open in another window 

 
Error adding font GM.TTF or the file GM.TTF could not be loaded 
▪ The font has not been added to your Windows font folder 

 
License key is missing or invalid! 
▪ Either no license key is present or it does not match the program 

 

License key does not match product! 

▪ The key file in the program folder does not match the program 
 
 

 
The requested file cannot be loaded in this application 
▪ The record file you tried to load is not matched to this program 

 
File saving attempt failed! 
▪ The record file has not been saved --- is the folder valid and do you hold the correct 

permissions to save to it? 
 

Target file already exists! 
▪ You are attempting to overwrite an existing file with this name 

 

Directory "%s" does not exist 
▪ The directory (folder) you are trying to save to or load from does not exist. 

 
No filename given 
▪ You have clicked on save without specifying a file name 

 

Export to "%s" has failed! 

▪ The data export you have set up has failed. Perhaps the folder name is wrong? 
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The hardware board with number %d is not recognized 
▪ The USB A/D board you have specified is not installed (open InstaCal to register the board) 

 
Error Code 10 - Invalid sampling rate (MCC UL Error 24 - Invalid sampling rate specified) 
▪ The sampling rate specified in the program setup is too high for the USB or PC hardware to 

cope with - alter the basic sampling rate in the Devices tab (File/Settings/Devices) 
 

Error Code 11 - The selected gain is not supported (MCC UL Error 30 - Invalid range specified) 
▪ This applies to the setting up of A1Test.exe, where the gain parameter has been 

incorrectly entered 
 

Error Code 12 - Sampling rate too high (MCC UL Error 29 - Overrun) 
▪ As 10 above 

 

Error Code 1001..1008 - Arithmetic error during computation 
▪ May be a PC memory issue 

 
Error Code 1009 - Signal below trigger level 
▪ Either there is no click, it is weak, or the microphone or cable is faulty. 
▪ (Use A1Test.exe to measure signal strength) If appropriate, VR2 may be increased if the 

signal is only a little below the trigger level or the trigger level setting can be reduced to 
below the measured signal level in the Acquisition (adv) tab. Details on how to use 
A1test.exe can be found below 

 

Error Code 1050 - Error saving calibration data! 
▪ The new calibration file generated has not been saved. Either the folder name specified 

during setup is not present, or you don’t have permission to write to it 
 

Error Code 2000 - Acquisition aborted 
▪ Software/hardware issue has prevented the program from running 

 

It is important that the software is loaded in the sequence suggested in the installation section of 
the A1 Acoustic User Software Guide. 

 

If issues arise when trying to use the system, the following can be used to check that the system 
has been correctly set up, and to diagnose any problems: 

ACOUSTIC ACQUISITION 
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InstaCal 
Navigate to the MCC (Measurement Computing Company) folder using My Computer and double- 
click on the program Inscal32.exe - C:/Program Files(x86)/Measurement Computing/DAQ. 

N.B. In a 32-bit system this will be C:/Program Files/Measurement Computing/DAQ as a 32-bit 
system won’t have an x86 folder. 

 

The opening dialog will show which boards are installed. 
 

• The board you installed should be numbered 0 (or the corresponding number in the A1 
software, if for some reason you have multiple devices installed) 

• Select Test from the top bar and Analog from the drop-down menu, then CH0, signal 
source External and A/D range +10V (for 201 USB interface) 

 

The line you see should lie on 0 Volts and should respond to talking into the open end of 
the sound tube – if this is ok then the microphone and connections between A1, the A/D 
card and the PC are ok. 
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EXPLANATION OF HOW InstaCal WORKS 

Each time InstaCal is opened, it looks to see what Measurement Computing Company interfaces it 
can find. The first one it finds it allocates to board 0 and the next to board 1, and so on. It records 
the board type and serial number and automatically edits a .ini file to include this information. 

 
If you change one acoustic system for another, it will have the same board type, but it will have a 
different serial number, which means that the USB will not be recognised and the driver will not 
be loaded. 

 

If you run InstaCal again, it will look for Measurement Computing Company interfaces. It will 
realise that the one already recorded is no longer present (by comparing serial numbers) and offer 
to remove it. When you answer yes, InstaCal will offer to record the new USB interface and when 
you click OK it will edit the .ini file to include the new board type and serial number. If board 0 is 
free, it will automatically allocate it to board 0, otherwise it will allocate it to the lowest available 
board number. 

 

It is for these reasons that you can't only unplug one A1 instrument and replace it with another. 
You must run InstaCal to let it recognise that the first one is no longer present, delete it, and 
replace it with the new one. 

 
If you have two USB devices connected, both can be registered by InstaCal   one as board 0 and 
one as board 1. Provided you go into the software of one of them (File -> Settings -> Device) and 
change it to board 1 then you can easily switch between each system without having to run 
InstaCal. 
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A1TEST 
In the A1 folder, you will find a program called A1TEST.EXE – this folder will be wherever you 
declared as the location during the installation process. 

 

Double-clicking on the name will start the application. 
 

For board type USB-201 select Gain = +10 volts, Digital Port = AUX, Sample Rate = 100000. 
 

Click on Sample. You should see the microphone response on the screen. If you point the mouse 
cursor under the trace, it will tell you the amplitude of the trace at each point. 

 

The baseline should be between 1950 and 2050 units. 
 

The value is only updated when you click on Sample. The picture below shows a typical display 
when the calibration plug is fitted to the sound tube and sample is selected. 

 

 

The peak pulse size is also documented in the table on the left-hand side as Maximum. 
 

It should peak at a level greater than that set within the A1 program for Trigger, and, using VR2, is 
normally set to between 3200 and 3500. 

 
If the peak height is smaller than this the level can be increased by using the gain control resistor, 
VR2, on the A1 circuit board. 

 

The trace above shows the microphone signal output plotted against sample numbers. 
 

The first large peak shows the response when the click sound reaches the microphone on its way 
up the tube. 

 

The second peak shows the reflected signal from the calibration plug returning back down the 
tube and reaching the microphone again. 

 

Each pair of pulses that follow show the event repeating, as the sound travels up and down the 
closed tube. 
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If the calibration plug is removed, the trace will change as shown below and you will be able to 
hear the click when Sample is selected. 

 

 

 

Selection of what constitutes incident and reflected waves is controlled by settings within the A1 
program for: 
incident wave window, 
reflected wave start point and 
reflected wavelength. 

 

These are set for a particular length of sound tube and should not be altered. 
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SUPPLIED PARTS  

INSTRUMENT AND ASSOCIATED PARTS GMI CODE QUANTITY 

A1 Acoustic Rhinometer A1-C ONE 
USB Cable GM-USB ONE 
Sound Tube A1-STM ONE 
Calibration Plug A1-CP ONE 
External Power Supply A1/PR ONE 
User and Software Manual DOC-A1-UM-001 ONE 
A1/MCC Software A1-C-SW ONE 
*Large Anatomical Nosepieces A1/NV1-PRL 5 Pairs 
*Medium Anatomical Nosepieces A1/NV1-PRM 5 pairs 
*8 mm Conical Nosepieces A1/NV1-PR8S 15 pcs 

CLINICAL/RESEARCH VERSION 
Artificial Nose and Straight Tube 

 
A1-AN.1 

 
ONE 

 
 
 

SPARE PARTS AND ACCESSORIES 
 

NOSEPIECES: 

*A1/NV1-PRM  Medium anatomically conformed nosepiece 

*A1/NV1-PRL  Large anatomically conformed nosepiece 

*A1/NV1-PR8S  Conical nosepiece 
 
 

MISCELLANEOUS: 

A1-CP Replacement calibration plug 

A1 Mic Sub Replacement microphone and inner sound tube 

GM-USB USB Cable 

If you have any questions about your Acoustic Rhinomanometer or require spare parts or 
consumables (part numbers listed above) then please contact your supplier or GM Instruments 
directly. 
We will be able to advise you and give you help with any problem you may encounter. 

 
 

Note: Parts listed above with (*) are supplied as non- sterile and due to their inertness have no expiry date. 
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MAINTENANCE MANUAL 

OVERVIEW 
 

The Acoustic Rhinometer should be calibrated each day using the built-in facility. In addition to 
this, the cables should be inspected regularly for signs of damage, in particular the region of the 
sound tube and its link to the PC. Do not use the equipment if damaged. 

 

The nosepieces supplied are for single-use only. Care should be taken in use to prevent the 
passage of nasal secretions down the nosepiece and into the sound tube. Should this occur, the 
sound tube should be removed from the sound box, cleaned by one of the methods described 
below and then thoroughly dried prior to reconnecting it to the sound box. 
N.B. Take care not to over tighten the fixing screws when re-fitting the tube as this could damage 
the tube. 

 

INSTRUMENT CLEANING AND DECONTAMINATION 
 

ENCLOSURE 
Should the enclosure require cleaning for any reason, unplug it from the PC and wipe it with a damp 
cloth or cleaning wipes. Do not allow liquid to run into the enclosure. 

 
SOUND TUBE 
Under normal use, employing the disposable nosepieces supplied, no routine cleaning is believed 
necessary. 

 

Should the sound tube enclosure require cleaning for any reason, unplug it from the A1 device and 
wipe it with a damp cloth or cleaning wipes. Do not allow liquid to run into the sound tube. 

 
 
 
 
 
 
 
 
 
 
 
 

COPYRIGHT NOTICE 

Copyright © G M Instruments Ltd, 2024. All rights reserved. 
Copyright Protection. 
Software and manuals are copyrighted, which means that your right to copy any part of them is limited by 
copyright law. Making copies or derivative works, except in certain limited instances and except for making 
copies for archival purposes or as an essential step in the utilisation of the computer program in conjunction 
with an instrument without prior authorisation is prohibited by copyright law and constitutes a punishable 
violation of such law. 
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Appendix 1: Guidance on the Electromagnetic 
environment in which to operate the instrument. 

 
 
 

Guidance and manufacturer’s declaration – electromagnetic emissions 

The A1 is intended for use in the electromagnetic environment specified below. The customer or the 
user of the A1 should assure that it is used in such an environment. 

 

Emission test 

 

Compliance 

 

Electromagnetic environment - guidance 

 

RF emissions 

CISPR 11 

 

Class B 
 

The A1 uses RF energy only for its internal 
function. Therefore, its RF emissions are very 
low and are not likely to cause any interference in 
nearby electronic equipment. 

RF emissions 

CISPR 11 

 

Class B 

 

The A1 is suitable for use in all establishments, 
including domestic establishments and those 
directly connected to the public low-voltage 
power supply network that supplies buildings 
used for domestic purposes. 

Harmonic emissions 

IEC61000-3-2 

 

Class A 

 

Voltage fluctuations / flicker 
emissions 

 

IEC61000-3-3 

 

Complies 
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Appendix 1: Guidance on the Electromagnetic environment in which to operate 
the instrument (cont) 

 
 
 

Guidance and manufacturer’s declaration – electromagnetic immunity 

The A1 is intended for use in the electromagnetic environment specified below. The customer 
or the user of the A1 should assure that it is used in such an environment. 

 

Immunity test 

 

IEC 60601 
test level 

 

Compliance level 

 

Electromagnetic 
environment - 

Electrostatic discharge 
(ESD) 

 

IEC61000-4-2 

± 8 kV contact 
± 15 kV air 

± 8 kV contact 
± 15 kV air 

Floors should be 
wood, concrete or 
ceramic tile. If floors 
are covered with 
synthetic material, 

Electrical fast transient / 
burst 

 

IEC61000-4-4 

± 2 kV for power 
supply lines 

 

± 1 kV for input / 
output lines 

± 2 kV for power 
supply lines 

 

± 1 kV for input / 
output lines 

Mains power 
quality should be 
that of a typical 
commercial or 
hospital 

Surge 

IEC61000-4- 

5 

± 1 kV line(s) to 
line(s) 

 

± 2 kV line(s) to 
earth 

± 1 kV line(s) to 
line(s) 

 

± 2 kV line(s) to earth 

Mains power 
quality should be 
that of a typical 
commercial   or 
hospital 

Voltage dips, short <5% UT <5% UT Mains power quality 
interruptions and voltage (>95 % dip in UT) (>95 % dip in UT) should be that of a 
variations on power supply For 0.5 cycle For 0.5 cycle typical commercial 

input lines  
40% UT 

 
40% UT 

or hospital 
environment. If the 

IEC61000-4-11 (60 % dip in UT) 

for 5 cycles 
(60 % dip in UT) 

for 5 cycles 
user of the A1 
requires continued 

   operation during 
 70 % UT 70 % UT power mains 
 (30 % dip in UT) (30 % dip in UT) interruptions, it is 
 for 25 cycles for 25 cycles recommended that 

  

<5% UT 

(>95 % dip in UT) 
For 5 s 

 

<5% UT 

(>95 % dip 
in UT) For 5 
s 

the A1 be powered 
from an 
uninterruptable 
power supply or a 
battery. 

Power frequency (50/60Hz) 
Magnetic field 

 

IEC61000-4-8 

30 A/m 30 A/m Power frequency 
magnetic fields 
should be at levels 
characteristics of a 
typical location in a 

NOTE UT is the a.c. mains voltage prior to application of the test level. 
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Appendix 1: Guidance on the Electromagnetic environment in which to operate the 
instrument (cont) 

Guidance and manufacturer’s declaration – electromagnetic immunity 

The A1 is intended for use in the electromagnetic environment specified below. The customer or the 
user of the A1 should assure that it is used in such anenvironment. 

 

Immunity test 

 

IEC 60601 
test level 

 

Compliance level 

 

Electromagnetic environment - 
guidance 

   Portable and mobile RF 
communications equipment should be 
used no closer to any part of the A1, 
including any cables, than the 
recommended separation distance 
calculated from the equation 
applicable to the frequency of the 
transmitter. 

Conducted RF 
IEC61000-4-6 

3 Vrms 
150 kHz to 80 MHz 

3Vrms Recommended separation distance 
(d) 

 
6Vrms in ISM bands 
between 0.15- 
80MHz 

6Vrms d = 1.2√P 

   
d = 1.2√P 80 MHz to 800 MHz 

Radiated RF 
IEC61000-4- 
3 

3 V/m 
80 MHz to 2.5 GHz 

 
3V/m 

 
d = 2.3√P 800 MHz to 2.5 GHz 

   Where P is the maximum output 
power rating of the transmitter in watts 
(W) according to the transmitter 
manufacturer and d is the 
recommended separation distance in 
metres (m). 

   
Fields strengths from fixed RF 
transmitters, as determined by an 
electromagnetic site survey,a should 
be less than the compliance level in 
each frequency range.b 

   
Interference may occur in the vicinity of 
equipment marked with the following 
symbol: 
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Proximity fields 
from RF 
wireless 

communications 
IEC61000-4-3 

Frequency - Test 
Level 

385MHz - 27 V/m 
450MHz - 28 V/m 
710MHz – 9V/m 
745MHz – 9V/m 
780MHz – 9V/m 

810MHz - 28 V/m 
870MHz - 28 V/m 
930MHz - 28 V/m 
1.72GHz - 28 V/m 

1.845GHz - 28 V/m 
1.97GHz - 28 V/m 
2.45 GHz - 28 V/m 

5.24GHz – 9V/m 
5.50GHz – 9V/m 

5.875GHz – 9V/m 

Frequency - Test 
Level 

385MHz - 27 V/m 
450MHz - 28 V/m 
710MHz – 9V/m 
745MHz – 9V/m 
780MHz – 9V/m 

810MHz - 28 V/m 
870MHz - 28 V/m 
930MHz - 28 V/m 
1.72GHz - 28 V/m 

1.845GHz - 28 V/m 
1.97GHz - 28 V/m 
2.45 GHz - 28 V/m 

5.24GHz – 9V/m 
5.50GHz – 9V/m 

5.875GHz – 9V/m 

 

Fields strengths from fixed RF 
transmitters, as determined by an 
electromagnetic site survey,a should 
be less than the compliance level in 
each frequency range.b 

 

Interference may occur in the vicinity of 
equipment marked with the following 
symbol: 

 

 
 
 
 

 
 

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 
 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by 
absorption and reflection from structures, objects and people. 

 
a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones 

and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be 
predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF 
transmitters, an electromagnetic site survey should be considered. If the measured field strength in 
the location in which the NR6 is used exceeds the applicable RF compliance level above, the A1 
should be observed to verify normal operation. If abnormal performance is observed, additional 
measures may be necessary, such as re-orientating or relocating the A1 

 
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 
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APPENDIX 2: TECHNICAL INFORMATION (relative to 
EN 60601-1:2006) 

 

Warning: No modification to this equipment is allowed. 
6.2 The A1 Acoustic Rhinometer is powered by an external universal mains power module. 
Power can be removed by unplugging the mains plug, or by switching power off at the mains 
socket. 

 

It complies with the specification for Class 1 ME equipment, and is used along with a PC and 
printer, normally supplied by the customer. 
N.B. The warning on page 3 about the PC and printer being compliant with EN 60950 and 
placing these items out of the reach of a subject 

 

The applied parts are the nosepieces which are classified as a type B applied part. 
 

6.3 The enclosure does not provide protection against the ingress of liquids and is therefore 
classified as IPX0. 

 
6.4 There are no parts which are supplied sterile or which are required to be sterile. 

 

6.5 The A1 Acoustic Rhinometer is NOT suitable for use in an oxygen rich environment. 
 

6.6 The A1 Acoustic Rhinometer is rated for continuous use. 
 

7.2.2 The A1 serial number can be found on the label on the back panel, and the software 
version number can be viewed on the start-up screen and by clicking on Help -> About… found 
on the top toolbar of the A1 software. 

 

7.2.3 Information is given in the Warnings and Cautions section (page 3) of this manual, which 
the user must read prior to operating this instrument. Appropriate labels are fixed to the back 
panel. 

 

7.2.4 Nosepiece packaging labels identify these as for single use only. 
 

7.2.5 The A1 power supply module is marked PCM50UT04. No other external supply can be 
used, unless supplied by GM Instruments as a replacement. 

 

7.2.6 The A1 power supply module provides DC voltages of ±12 volts and + 5 volts from an 
input which can range from 100 Volts to 240 Volts AC at 50 Hz to 60 Hz. The power supply 
module is rated at 42W. 

 
7.2.7 The A1 consumes 10W. 

 
7.2.11 The A1 Acoustic Rhinometer is rated for continuous use. 
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7.2.17 Environmental conditions for transport and 
storage. Temperature: -40 °C to +60 °C 
Humidity: 30 to 90% RH 

7.9.1 The A1 can be used by any medically-trained technician, nurse or doctor, who has either 
read this manual or who has been trained by a competent authority in its use. 

 
7.9.2.2 Warning: To avoid risk of electric shock, this equipment must be connected to a mains 
supply with protective earth. 

 

7.9.2.3 The power module provided with the A1 (PCM50UT04) is considered to be part of the 
ME equipment. 

 
7.9.2.5 The nose pieces are considered to be the applied part. 

 

7.9.2.7 The equipment should be positioned so that it can be disconnected from the mains 
supply quickly and easily. 

 

7.9.2.10 Error Messages --- see A1 Troubleshooting on page 19. 
 

7.9.2.11 The A1 software can be closed by clicking on File -> Exit from the main toolbar. The A1 
hardware can be switched off by removing the mains plug or by switching off the mains plug at 
the socket. 

 

7.9.2.13 There are no parts which need routine maintenance or servicing other than general 
“housekeeping”, such as keeping the equipment clean and cables free of twisting. Operational 
tasks such as calibration, and performance adjustments using the straight tube and artificial 
nose, are described elsewhere in this manual and in the sheets which accompany the tube and 
nose. 

 
7.9.2.15 The applied parts (nosepieces) should be disposed of after use in line with your 
hospital or clinic's policy on disposal of potentially contaminated plastic parts. 
The A1 Acoustic Rhinometer can be returned to GM Instruments for dismantling and disposal, 
while your PC/Printer should be returned to your supplier for dismantling and disposal. These 
parts are subject to the WEEE directive and should not be disposed of in landfill. 

 

7.9.3.2 The only parts which are interchangeable by service personnel are the power module 
and the mains cable. If these are changed, a PAT test to the current standard should be made 
prior to allowing release for use. 

 
7.9.3.3 Circuit diagrams, component lists, and parts lists are available on request, along with 
email/telephone advice to service personnel trained on EN 60601-1:2006 and qualified to work 
on ME devices. Modification of the A1 Acoustic Rhinometer is not allowed. 

 
7.9.3.4 If access to the A1 circuit board is required: 

 
Disconnect the A1 from the mains supply by unplugging or switching off at socket 

• Turn the unit over and remove the four feet on the base using a screwdriver 
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• Carefully turn the unit back over and remove the top panel 

• The circuit board can now be accessed and, if voltage measurements are required, 
the mains power can be reconnected 
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USER SOFTWARE MANUAL TABLE OF CONTENTS 

 
SOFTWARE INSTALLATION PAGE 5 

 
 

HOW TO CONFIGURE THE SOFTWARE PAGE 39 

 
 

STARTING A TEST 
 

TO PREPARE FOR MEASUREMENTS ON A NEW SUBJECT PAGE 54 

TO PREPARE FOR MEASUREMENTS ON A REPEAT SUBJECT PAGE 54 

 

TO MAKE A NEW ACOUSTIC RHINOMETRY RECORD PAGE 55 

TO COMPARE TEST RESULTS (L/R AND L/R-PRE AGAINST L/R-POST)      PAGE 57 

TO DELETE A TEST RESULT PAGE 60 

BATCH TEST FACILITY (CLINICAL/RESEARCH VERSION ONLY) PAGE 60 

 
 

DATA EXPORT FACILITY (CLINICAL/RESEARCH VERSION ONLY) PAGE 63 
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SOFTWARE INSTALLATION 

COMPUTERS SUPPORTED 
The A1 can be made to work on any PC which runs a Windows based operating 
system which has a free USB socket 
N.B. Units which comply with EN 60950 should be used. 

 

PRINTERS SUPPORTED 
As these instruments operate in a Windows environment, print capability depends on 
you having installed a printer under Windows. Virtually any printer, which works under 
the version of Windows you have, will be suitable. 

 

INSTALLATION SEQUENCE 
The software comes on 2 CDs or 1 Thumb Drive (containing 2 folders). It is advisable 
to close any other programs you may be running while performing the installation as 
you may need to restart the PC during this operation. 

 

INTERFACE BOARD SOFTWARE (Measurement 
Computing) Ensure the USB cable is NOT 
connected to the A1 unit. 

If you have an MCC DAQ disk, put it in your drive and allow it to auto run, or open it 
and click on Install. You only need to install InstaCal/Universal Library software from 
this disk. Other options such as Tracer and manuals are not required. 
If you have a Thumb Drive put it in a free USB socket and navigate to it. Open the MC 
folder, and click on icalsetup.exe. Accept the defaults offered. 
The program InstaCal and other driver software will be loaded to a folder called 
Measurement Computing. 

 

INTERFACE BOARD HARDWARE 
The next installation operation is to have your PC identify the USB A/D converter, 
which is built into the A1 unit. To do this, connect the A1 to your PC using the cable 
supplied. (It is not necessary to power up the A1 or at this stage or load its software) 
Click on the Start button, scroll down to Measurement Computing, select it and 
scroll down to InstaCal and click on it. InstaCal will show no boards installed as 
shown below. 

 
 

Wait for a few seconds as the USB interface is recognised and the drivers are loaded. 
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If this doesn’t happen, click on Install, then Refresh. Once completed, the InstaCal 
screen will offer the opportunity to accept your USB board. 
N.B. the serial number for the USB in each A1 is unique. The most recent units are 
for type 201, while older A1 units will have a 1208 USB module installed. 

 

 

Click on OK 
 

 

 

When InstaCal shows the screen above, (shown for a 201 module) USB installation is 
complete and InstaCal can be closed. 

 

GMI SOFTWARE 
Put the GMI CD in your drive or open the folder A1 on your Thumb Drive. Navigate to 
the file Setup-Acoustic_V3_X_X_XXXX.exe and click on it. Accept the defaults offered 
at each stage, until you are asked for the desired location for the .ini file – you will be 
offered the choice of the shared folder or the application folder. Unless you plan on 
using the system on a network, the application folder should be selected. 

 
The A1 Acoustic Rhinometer program can now be started by clicking on: 

 
The Start button and from the program list select Acoustic, then Acoustic. 

 
The program opens a blank patient file as shown: 
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If you wish to change the fields listed in the Patient Record screen, this should be 
done at the beginning, before starting to save records. To do this, click on File, click 
on Close, click on File, click on Settings, select the Patient Record Tab and make the 
alterations you want, as described in the following pages. 

 
If you wish to make measurements on a New subject, click on File, click on Close, 
then click on New. 

 
If you wish to bring back a record of a Patient previously tested, click on Open. 
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HOW TO CONFIGURE THE SOFTWARE 

Several elements within the program can be configured to suit your application. 
N.B. Although you may wish to reconfigure these elements again later it should be 
noted that fields within the Patient record screen cannot be changed after storing 
results for a particular subject as the stored information may become inaccessible – 
see page 10 for more details. 

 

All changes are made by clicking on File -> Settings. 
N.B. The values shown on the following screens (and particularly in the acquisition 
screens) are examples only, as every system is individually configured. 

 

A new window named Settings is then displayed which shows two super-tabs, each 
of which contains subtabs with user-configurable items. The two tabs are labelled 
General and Acoustic. 

 

GENERAL > USER INTERFACE TAB 
 

 

The General > User Interface tab allows you to: 
 

• Show captions on the toolbar buttons 

• Show the PC system time in the status bar 
• Enable the middle mouse button to open the acquisition window 
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• Make the system adjust the graphics display following a test to allow space 
for the table of results appropriate to that test 

• Make the system match the language set on the PC to any of the options 
supplied with the A1 software, when possible 
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GENERAL > PATIENT RECORD TAB 
 

 

 

The General > Patient record information window can contain many fields. You can 
include as many or as few as you want, put them in any order, define what kind of 
data is acceptable for entry in any field and specify the size of each field. 

 
The Patient Record tab contains the following elements: 

 

List of fields is a window which shows the current labels already selected for 
inclusion. If you click on one of these it can be edited or deleted or its position 
moved within the group. When highlighted, the information relating to its structure 
is shown on the right-hand side of the window under the following headings: 

 

Caption - the current label selected for editing 
 

Maximum Length - the number of character spaces allocated in the Patient 
Information window against that name 

 
Input mask (format) - the conditions applied to character entry in the associated 
Caption field 

 
In the above example, ID no. is highlighted in the Lists of fields window. The label ID 
no. is shown in the Caption field and it can be seen that currently space is allowed 
for 15 characters. The applied mask was one which only allowed valid filename 
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characters, and no spaces or other characters. Masks can be selected or changed by 
clicking on the button on the extreme right of the Input mask (format) field. 

 

 

 

The Input masks window allows selection of the conditions you want to apply and 
has space below for you to test the restrictions. If you wish to keep the currently 
selected field, click on OK, and then on Apply. 

 

If you wish to discard any field, highlight that field and click on Delete. If you want to 
add a new one, click on New. 

 

If you want to change the order in which they appear, highlight the one you want to 
move and then use the Up and Down arrow buttons to the right of the Delete 
button. 

 
You can place more than one item on a line by placing it below the item you want it 
lined up with and clicking on Position on same line as previous field. 

 

You can also hide a field from a printout by highlighting it and clicking on Hide on 
printouts. 

 
A field can be used for the test file name by highlighting it and then clicking on Use 
for suggestion of filename. 

 

N.B. The software will open in a blank patient record. If you wish to add or remove 
any fields from the Patient record screen or make changes to them you must first 
close the current record by selecting File -> Close from the main toolbar. 
(This software enhancement has been made to stop patient files being accidentally 
corrupted – a side effect of a patient record being changed while open within the 
software). 
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GENERAL > STYLES TAB 
 

 

 

The General > Styles tab allows you to set up colours and line styles for either the 
screen or the printout. 

 
Target - here you can select Application user interface (screen) or Report (printer) 
for alteration 

 

Plot Item - scrolling window which contains a list of the screen or printout elements 
whose colour, line style, or font can be changed 

 

Color - colour palette, from which you choose the colour you want applied to the 
element selected in the item window 

 
Style - displays the colour, line style or font currently set for the element shown in 
the item window 

 

Pen Style - allows you to set different types of line for the selected element 
 

Thickness - allows you to apply different line thickness to any line drawing element 
selected from the item window 

 
Preview - window which lets you see the effect of a change 
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To make a change to the default settings select Application user interface (screen) 
or Report (printer) from the top dropdown menu, select an Item from the list, select 
your desired Pen colour and, if appropriate, Pen Style or Thickness. You can 
immediately see the effect of that change in the Preview window. 

 
If you click on Apply, the change will be recorded and you can move to another 
element. If you click on OK instead of Apply, the change will be made, and recorded, 
but you will close the Setup window and return to the main screen. 

 
 
 

Application User Interface (screen) & Report 
(printer) 

Item Name Item Description 

Acoustic Plot 
Background 
(Testing screen only) 

The background colour of the graphs viewed on the screen 
during testing 

Axis Labels Numbers marking the axes on the A1 graphs 

Matrix The non-zero grid lines for each graph 

Curve 1 – Curve 10 Each of the captured curves shown on a graph at any given time 

Acoustic MeanBase 
(L+R) 

Colour of the left and right baseline curves when performing a 
comparison 

Acoustic MeanComp 
(L+R) 

Colour of the left and right comparison curves 

Acoustic Goldnose Curve relating to the Goldnose Acoustic Rhinometer calibration 
device 

Graph Border / Graph 
Area 

Colour of graph borders and background areas 

Axes Zero lines on the graphs 

Results Values Text All text in the tables 

Subgraph Caption Text in the “Remarks” box in the bottom right corner of the 
screen 

Legend: Item Text/Box 
Frame/ Box Background 

Colour of the frame, background within the frame and the text 
within the frame of a legend describing the information 
contained within a graph 

Patient Record 

Background 

Background of the main screen where patient details are 
entered 
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GENERAL > REPORT TAB 
 

 
 

The General > Report Tab allows for the setting of a title which will appear on 
printouts and the alteration of printer margins. More detailed control of printer 
options is available in the normal Windows print driver dialogue box. 
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ACOUSTIC > DEVICES TAB 

The Acoustic > Devices screen shown below displays the USB device number 
assigned to the instrument [0]. If you then click on the device (A1 Acoustic 
Rhinometer, in the below example) the buttons at the bottom of the window 
become active. 

 

 

If you click on Configure, you will see: 
 

 

When the USB interface is installed (USB-201), the window will show: the board 
number [0], the channel used for the microphone (which, by default, is channel 0), 
the selected gain setting (±10 Volts), the basic sampling frequency (100kHz), the 
upsampling option will be disabled, and the pause between each measurement (700 
mS). These are the default settings for a USB-201 interface and should not normally 
be changed. 
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N.B. Earlier versions of the A1 may have also used a USB-1208FS interface, in this 
instance the window will show: the board number [0] and the channel used for the 
microphone (0), the selected gain setting (±1.25 Volts or +10 Volts), also displayed 
are the basic sampling frequency (46kHz), the data processing upsampling 
equivalent (100kHz) and the pause between each measurement (700 mS). 

 

 

When you click on Calibrate in the test acquisition window, you should have the A1 
powered up, with the calibration plug fully inserted into the A1 sound tube. An 
updated calibration file will be generated and saved to the default folder – the same 
directory to which the program was installed. 

 
The Add and Remove buttons allow the interface to be changed, if, for instance, you 
have an NV1 Rhinospirometer, which you want to install on the same PC. Each 
interface will be assigned a different number by InstaCal, and, therefore, as the 
default setting for both instruments is board 0, one or other must be changed to 
allow both to work. Normally there is no need to alter these settings. 
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ACOUSTIC > ACQUISITION TAB 
 

 
 

Side - sets the side of the nose which is, by default, to be tested first. 
 

When acquiring acoustic data, the information can be obtained from a single 
measurement or from the average of a series of curves. The item labelled Number of 
traces specifies what is to constitute a single test. 
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ACOUSTIC > ACQUISITION (ADV) TAB 
 
 

 

All the parameters set up within this dialog box are pre-set by GM Instruments, to 
give best possible performance on your system, and are stored on your program CD. 

 
Every sound tube is different and, therefore, may have different setup parameters 
associated with it. 

 
The Distance shift factor allows a small lateral movement of the measured data 
curve to give the best fit when comparing a measurement made with an artificial 
nose against the theoretical line produced by the profile of an artificial nose. It 
effectively compensates for variations in the speed of sound under different 
conditions. 

 

Sound tube area, Zero adjust, Stability, Starting point shift and Attenuation factors 
are adjusted to provide optimum results when setting up the system using with the 
artificial nose and straight tube, as recommended by the standardisation committee. 

 
The Max distance factor is normally set to 25 mS to limit the size of the files which 
are created and saved. Normally, scaling of the horizontal axis is set to run from –5 
cm to +15 cm, so the minimum requirement is a maximum distance of 20. If you 
want to measure further back, say to 25 cm, then the horizontal scale would need to 
be set to run from –5 to +25 and the maximum distance set to at least 30. 
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If an improper data message is produced during acquisition the Trigger level factor 
can be reduced to allow measurements to be made. 

 
Data windows parameters are based on the physical dimensions of every sound 
tube and are, therefore, constant for every sound tube. 

 
Nosepiece Length allows you to tell the software what nosepiece you are using to let 
it adjust the graphical display accordingly – this will normally be 4.5 cm. 
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ACOUSTIC > RESULTS TAB 
 
 

 
 

Volume calculation start distance and stop distance specify the section of the nose 
over which you want to calculate a volume. 

 
Cross-sectional area minima specifies the section of the nose over which you want 
to look for turning points, and Hysteresis specifies what constitutes a turning point. 

 
Comparison ranges allows you to specify the volumes reported between up to 5 
pairs of distances, when a comparison display is on screen. 

 

Comparison distances allows you to specify up to 5 distances at which cross- 
sectional areas will be reported when a comparison display is on screen. 

 

Miscellaneous 
The Include totals tick box is offered here to allow the standard result screen, when 
showing right and left side volumes etc., to also give a total nose figure. This 
summation may not be appropriate if you want to compare two right side or two left 
side measurements, and can therefore be switched off here. 
Although the system will automatically report MCA1 and MCA2 (the first and second 
Minimum Cross-Sectional Areas found, starting from the front of the nose), it can 
also automatically determine which is the smallest and report it as MCA, if the box is 
ticked. 
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ACOUSTIC > PLOT TAB 
 

 

The scaling for the distance and cross-sectional area axes can be set up here, for the 
Linear plot and the Logarithmic plot, comparison and analysis view screens. 

 

N.B. A logarithmic scale should not be assigned a minimum value of zero. 
 

Miscellaneous 
A tick box is offered to allow the side used to display the left/right results to be 
switched for comparison tests. 
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ACOUSTIC > REFERENCE DATA TAB 
 
 

 
 

Validation of system performance can be made by comparing a theoretical Standard 
nose curve, with that obtained when making a measurement on a Standard nose 
model. 

 
The A1 GMNose allows such a system check to be made. The Acoustic > Reference 
data tab shown above, allows the appropriate theoretical curve to be drawn on the 
screen in a colour and line style specified in the General > Styles tab, under control 
of check boxes on this screen. 

 

The Datafile used under normal circumstances is called GMNOSE.DAT and can be 
selected from file by clicking on the button to the right of the Datafile window. The 
selected data file can be shown on screen if Visible on screen is selected and can be 
seen on printouts if Visible on printouts is selected. 

 

The Datafile is drawn behind measured curves provided the 3rd tick box is selected. 
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STARTING A TEST 
 

TO PREPARE FOR MEASUREMENT ON A NEW SUBJECT 

1. All current patient information and test results are cleared when the 
program is started, or if, having performed other measurements, you click 
on the New button. 

2. In either event the cursor is set to the first field in the patient record 
window. 

3. You can then enter the required patient details. Pressing the tab key after 
entering information in each field will take the cursor to the next one. 

4. To make measurements (acquire), click on the Acoustic icon on the top 
toolbar. 

 

TO PREPARE FOR MEASUREMENT ON A REPEAT SUBJECT 

 
1. Click Open and then, using the dialog box offered, go to the folder you 

store your results in and click on the appropriate subject’s file name. 
 

2. You will then be able to examine the patient details and check that you 
have the correct subject by clicking on the Patient record tab. Clicking on 
the Tests tab will show you all previous test dates and results for that 
patient. 
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TO MAKE A NEW ACOUSTIC RHINOMETRY RECORD 
 

Click on the Acoustic icon on the top bar and one of the following two windows will 
appear: 

 

1) If no calibration file is found you will be prompted to Calibrate. With the 
A1 switched on and the calibration plug securely fitted to the end of the 
sound tube, click on the button marked Calibrate. 

 

 
2) If a calibration file is found, you will see the screen below and can 

proceed to testing, or alternatively you can refresh the calibration by 
ensuring the A1 is switched on and that the calibration plug is correctly 
fitted, and clicking on the button marked Calibrate. 
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3) On the top bar, the number of traces representing a test can be changed 
from the default number (4). If you have a clinical/research version you 
can also switch on Batch mode to allow result validation (see page 28 for 
more details). The facility Trigger on zero flow is a specialised feature 
used in conjunction with a research-based combined acoustic and 
rhinomanometer sound tube. 

 

4) Confirm that the side you want to test is selected (left or right), and once 
the patient is connected, click on the button with the red spot on it or, 
provided the mouse cursor is within the acquisition screen and you have 
this setting selected, your mouse middle button to begin the acquisition. 

 
5) Once the pre-set number of measurements has been taken the system 

will stop taking in data, will show you the resultant curves, each of which 
is drawn in a different colour, and will add the test to the test list for that 
subject. 

 

 

6) If any curve is obviously bad it can be de-selected by clicking in the 
appropriate check box in the Traces section on the right of the screen. 

 

7) Comments can be added in the box found on the bottom right hand side 
of the screen by clicking Edit…, or removed by clicking on Clear. 
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8) If required, additional testing can be done, or the current test can be 
printed by clicking on Print, or it can be saved by clicking on Save – if a full 
screen printout is required, the desired test should be highlighted and 
Print on full page should be selected by clicking on the arrow next to the 
Print icon. 

 
9) The Output tab can be used to create a printout consisting of a number of 

curves selected by clicking in the check box on the left of the test list. 
 

10)  Additional facilities available from the screen includes: 

Import --- This allows you to merge data from two saved files 

Export --- This allows the raw data to be sent to a text file 

Copy --- This allows the calculated values to be put on the 
clipboard, ready to be pasted into a spreadsheet 

 
 

TO COMPARE TEST RESULTS (L/R AND L/R-PRE AGAINST L/R-
POST) 

 
If you want to create a complete nose record from Left-side and Right-side results: 

 
1) Select the Tests tab 

 

2) Click on a Left test using the left mouse button 
 

3) Hold down the ctrl key and click on the desired Right test using the left 
mouse button - both tests will now be highlighted. Release the ctrl 
button, right-click on either test result and click on Create comparison 
test 

 

4) A new test entry is created which shows the Left curve and the Right 
curve, which can be displayed in a number of different ways by selecting 
different toggle buttons, which are found below the graph 
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The above illustration shows a L/R comparison test, displayed in Report style. 
 
 

If you want to create a test which compares two Left side or Right-side results: 
 

1) Select the Tests tab 
 

2) Click on the test you want to use as the baseline test using the left mouse 
button 

 

3) Hold down the ctrl key and click on the test you want to be the 
comparison test using the left mouse button. Both tests will now be 
highlighted. Click on one of the tests using the right mouse button and 
from the drop-down menu, click on Create comparison test 

 
4) A new test entry is created called COMP, which shows both curves. This 

can be displayed in a number of ways, which can be toggled via buttons 
beneath the central window 
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It is also possible to compare a pair of total nose records. In this case one pair (L+R) 
record is designated as the baseline result and a second pair (L+R) is designated as a 
comparison result (colours and line styles for these are specified in the Style tab). 

 
Left-click on one L+R curve to designate it as the baseline, then hold down the ctrl 
key and click on the L+R curve you wish to compare against. Right-click on either test 
and select Compare to produce a new record entry. 

 
This new record is called an ANALYSIS record. When selected, a detailed 
examination of the two sets of results is possible, and the % change at different 
points is calculated. 
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TO DELETE A TEST RESULT 
Select the test result to be deleted from the test list using the left mouse button to 
view it on screen, then right-click on the test and, from the menu which appears, 
select delete. 
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Batch progress 
dialog box 

Batch results 
and print box 

Batch test selection 
box 

BATCH TEST FACILITY (CLINICAL/RESEARCH VERSION ONLY) 

Validation of test results is a facility which has proved to be invaluable in many 
situations. In acoustic rhinometry result variation is normally caused by distortion of 
the nose or leakage in the connections to it. 

 

The batch test facility has been incorporated into the Clinical/Research version of the 
program in order to allow users to check for these sources of result variation. 

 

The program offers the possibility of switching on the Batch process when you go 
into the acquire screen, by clicking on Batch mode in the top right corner of the 
window. An additional section of window is then added to the acquire screen, where 
a number of pieces of information will be added as test results are taken. 

 

 

At the end of the first test Start batch will be shown in the progress dialog box. At 
this point the subject should be disconnected from the equipment, and then 
reconnected. 

 

The red button in the bottom left corner should be clicked on again to start part two. 
Once completed, a coefficient of variance figure (CV) will be shown in the progress 
box, while additional information such as the mean resistance, standard deviation 
between values, and the CV figure are shown in the results section. 
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If the CV figure is low then there is a strong likelihood of the values being accurate, 
as the chance of creating the same distortion or leakage twice in succession is 
remote. 

 
However, additional tests can be added to the batch (with the subject disconnected 
between each) if you want further re-assurance. 

 

The batch values can be printed directly without any possibility of modifying the data 
by clicking on the batch print button. 

 

When you close the batch test window, the tests are transferred to the normal test 
list for further examination and permanent storage. 
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DATA EXPORT FACILITY (CLINICAL/RESEARCH VERSION ONLY) 

STANDARD PRINTOUTS 
Graphical and numerical information can be outputted in the form of printed records 
either directly from the Tests screen by selecting the records required and clicking 
on the Print button, or as a composed report by clicking on the Output tab and 
selecting the records you want on your report. These can be viewed on the right of 
the screen prior to clicking Print. 

 

SCREEN TRANSFERS 
A single tap on your keyboard’s Print Scrn key will transfer the contents of the 
screen to the clipboard, which can then be pasted into other record-keeping 
systems. 

 

DATA OUTPUT 
Numerical information can also be outputted from Clinical/Research versions of A1 
in two ways. 

 

1) Cross-sectional area values at pre-set time intervals: 
 

This is done by saving a record or group of records to a file of type .DAT. 
The .DAT format saves cross-sectional area values sequentially at a fixed distance 
interval, which depends on the acquisition rate. At the standard sampling rate of 
100kHz, area values are presented every 1.73 mm along the distance axis. 
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Click on Save, select files of type .DAT, enter the file name, if not entered 
automatically, and then click on Save. The saved file can then be viewed in Notepad 
or put into other software for processing. 

 
 

2) The Clinical/Research version of the software includes an export facility, which 
can be found under the File drop-down menu, which, when clicked, presents 
you with a setup dialog box: 

 

 

This allows you to select what patient information you want to export to a file of 
type .EXP, and whether the information should be calculated values, raw data, or a 
mixture of both. 

 
As a companion to the .EXP file, a .DEF file can be created at the same time which 
names each item of data in the .EXP file. 

 

Both types of file can be opened within commercial packages such as Microsoft 
Excel and subsequently processed in any way you wish. 
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